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Nattaphongs Julagatepotichai 2007: Impact Evaluation of Leakage and Explosion of
Hazardous Substance for Emergency Plan: Case Study of Light Hydrocarbon Gases
Tank in Petrochemical Industrial. Master of Engineering (Safety Engineering),

Major Field: Safety Engineering, Interdisciplinary Graduate Program. Thesis Advisor:

Associate Professor Penjit Srinophakhun, Ph.D. 106 pages.

The purpose of the research is to access the impact of leaking and exploding of the
hazardous substance in petrochemical industrial. This research will be taken as a case study for
arranging and planning for support the emergency situation. The researcher decided to use the
ALOHA program in the simulate situation to inspect the impact. The result from this situation
will be applied to use with geographic information systems (ArcGIS) program which can
indicate the location where trend to receive the effect. Therefore, the researcher can plan the

method to control the situation and find out the path for moving out the people.

In the case study from a plant at Rayong province, the researcher determined the
simulate situation of the exploding and leaking of four big chemical tanks. These four chemical
tanks are contained the discrepant chemistries such as Ethane, Ethylene, Propane and Propylene

by limit the quantity and differ in controlling treatment for each tank.

The researcher had arrange the level of leaked and exploded of the hazardous substance
base on the range of distance where receive the effect from the most to the less. As the result,
the chemical which create the critical effect from leaking is Propane, Propylene, Ethylene and
Ethane respectively. On the other hand, the chemical which create the impact of exploding the
most is Propylene, then, Ethylene, Ethane and Propane respectively. The range of the impact
from Propane leaked in maximum level is 152 meter and from Propylene exploded in maximum
level is 4,300 meter. As mention, the range of leaking in the maximum level is not effect to the
nearest hospital, where is away form the plant around 1,900 meters. But, on the other hand, the
exploding can cause the effect to this hospital. So, the researcher has to move the victim to the

hospital outside the effected area instead.

Student’s signature Thesis Advisor’s signature



paanssudszma

4 S A
%’lWL%’W@ﬂﬁﬂJﬂl'ﬂ‘UWﬁgﬂﬂl TONAITATINTY ATANYINT f'ﬁUWﬂﬂ! Uses1unssums
A (R s ~ A (= a Ay Y A
N15nu1 Hazseemng 195y As. ‘ﬁ\illsb'ﬂ ATUNAM N3sUMINYsnuIvuen ‘Vlllﬂsb"lﬂlﬁa@
av a a J v dy Yo =< ° 14
Gluﬂ1§'3']\1l!W1l\111!’J%ﬂﬁlujﬂﬂ']uwu‘ﬁﬂﬂﬂu @ﬁﬂﬂﬁ]uﬂ”liGlﬁﬂ'lﬂiﬂ‘l%l'lllugu'lﬁiﬂfﬂllﬂllell
9 [ [ o A a ’q Yo < 1 9 =S
ﬂlﬂﬂﬂWi@Qﬂ']\i"]Gll‘lﬂ']'i‘ﬂ']'JVIﬂTUWUﬁﬂlﬁﬁ'llﬁﬂqa'Nllﬂﬂ'Jﬂﬂ

a Jd

k4
YOUDUNIZAM AMTNIU AINBINI MIaugadrnssunralszmalng , quging

q

a A @ o aov

a a 1 % { o
NAAHNYY ammmuﬂu’qmmﬂﬁmmmﬁqm%’%’agaiumm o, naudaY P1INAA ,

Y
IS4

N = 9 9Y v o W = A A
ﬂﬂ!ﬂfﬂﬂ! ANNDINT |, AlADNa ‘].]i%fﬂfliq\i‘ﬂf’]\i , @mﬂuuaﬂﬂummm FIANDINLASINDOU
T NI TIINUGATINNTIN NILNINYAAIMNTIN , ANFA T TgULAL NRITTAUINA

A s A Aq Yo (=2 9 o Aa a s
ﬂuiJﬁ'l’ﬁﬁi ﬂﬁq\?!‘VI‘WSJW'Iuﬂﬁ LRAZUIINAITIY lla’lﬂﬂiﬂﬂ’lﬂiﬂ‘hl’] IWLLHUT]WQGluﬂ'ﬁ‘V]TTVIEJ'IHWHﬁ

1 A 9 1 Yo < 1
nazsIemae lud a1 lduiegan

yovounaminNlszd lasamsnnlnsainmsinanssuanuilaoaio maniay
a 4 a [ 4 1 A 1 ~ 9Yq Yo o
AUZIAINTTUANAAST UNINGBINBATAIAAT NN wazougy 5 A la A uuziinas

$1UIWANVALAINAI IUIVMITANHIAILA

@ 4 a o
I gaung Indde

WU 2550



a3vey

fefunedydnuaitaziide

d aw
ailszaenveansddy
MIATINBNAT
4 ax
9Un3alazITNg
gilnsal
an
M3
a 4
AGIGERRR L
o Ay Yo
MIRUIUMITZEz NN IdTURansz N
79 ¥ "o a s A
maszendlelalsunsy ALOHA Sfussuuasaumagimasiie
2 o 4
asndouiuni IdsuransznunInmsia lnanazmsszdavesingduaiie
MITAMUNUTDIT VAR Y
agduazdorauonus
a31)
9
VOIAUDUUE
PNENTUAZAI019D4
MANUIN
MARLIN N ANANUzIazANANAveIngduasIeNIzANEIITe
MANUIN U TANHUDIMATINIATLEDY
MANUIN A ArcMap ALOHA Import Tools
MANUIN 3 ArcGIS Network Analyst Tutorial

1523amsAnsT tazmIiau

(1)
2)
(€)
(5)

22
22
22
24
24

41
47
56
56
57
58
60
61
77
79
84

106

(1)



2

a3UYAI

M9 Hin
1 ALOHA sources and scenarios. 7
2 Thermal radiation burn injury criteria. 9
3 Explosion overpressure damage estimates. 10
4 dnvazvounasimiialuseaumg 18
5 uaastoyat UMz Yo UATiNeHUT5Y Ethane 27
6 ueadoyas uNIZVeUATIAZDIU55Y Ethylene 31
7 ueadoyas uNIZYeUATIAZBID55Y Propane 34
8 ueadoyas uNIZYeUATiAZiID559 Propylene 38

9 nSeufieuszesnansenuanmsia luauas Safinanseny
NN 40
10 AmauNIMIsziiatazlsmuveingduasy 41
11 Hazardous (Classified) Locations 52

12 WanmMslany 53



MN

10
11

12
13
14

15
16
17

18
19
20

=).

AUy MN

Gaussian distribution (left) and Gaussian spread (right).
Cloud spread as a result of gravity.
dnyzYTTUUMSAUMAYIManT
4 a o
l!ﬁﬂ\‘l@\iﬂﬂigﬂ'ﬂﬂﬂl@\?igﬂﬂﬁ'ﬁﬁul%ﬁ@]ﬂﬁ’lﬁ@ﬁ
Tumsdadmsuiagnuaaslumsiumun
[
msutlasdoya Vector 111 Raster
Avd19doyallszinn Raster
Avg1doyailszian Vector
a a a < a o (:JI 1 A
lmu@,uﬂ'ﬁwaﬁiﬂLaWUﬁLLﬂZW@ﬁﬂﬂ!cﬂﬂluﬁﬂLu@\i
1911559 Ethane
M v g ]
Sgﬂgﬂlﬂﬂﬂﬁﬂizﬂﬂﬂiﬁ Ethane i'Juh‘ia@@ﬂ’ﬂ’]ﬂﬂﬂlﬂﬂiu‘ﬂu’lﬂﬂl@ﬁ
Y 9 [y v
mmmﬁuu“luﬁmumm
=t a v A 9
TANUNTILIUAVUD Ethane Lm’ﬂﬂiuzﬂﬂlﬂﬂﬁﬁﬁﬂﬂ’]ﬂﬁﬂu
891357 Ethylene
o v < ]

3$ﬂ$ﬂlﬂﬂwaﬂixmﬂﬂiiﬁ Ethylene ijqﬁﬂﬂﬂﬂﬂTﬂﬂQLﬂﬂiuWujﬂ

Yy 9 [ '
madﬂ’gmwmmcluimumm
[ = a o A 9
IANNITTEIUAVDY Ethylene Llﬁﬂﬂiugﬂﬂlﬂﬁﬁﬂﬁﬂﬁ"miﬂu
ffﬂ‘]ﬁ'ii] Propane

o v < ]

igﬂgﬂl'ﬂQWﬁﬂﬁg‘ﬂ‘Uﬂiﬂdﬂl Propane fl"f]ulﬁﬁ@'i]ﬂinﬂﬂ\uﬂﬂ‘luﬁujﬂ

Yy 9 1Y 1
"UE]\W]'J'INL"UNGUHGI,‘LlﬁgﬂU@n\‘]‘V]
v A a v A Y
TAUNITTISIUAUDN Propane Llﬁﬂ\iﬁlugﬂmﬂﬂi\‘]ﬁﬂﬁ'lﬂiﬂu
NUTT 9 Propylene

o v I ]

3$ﬂ$ﬂlﬂﬂﬂﬁﬂﬁ$ﬂ‘ﬂﬂiﬁ Propylene ﬁ?llﬂﬂ@@ﬂ%'lﬂﬂ\‘llﬂﬂaluﬁu’Jﬂ

oI NN T TRV

3)

15
16
19
20
21
21
25

27

28
29
30

31
32
34

35

36

37

38



=D.

NN
21
22

23

24
25

26

27

28
29

MNHUINT

U1

a3UYNN (519)

Salim3sziiave3 Propylene taaslugduesssdnnuion
& a D) A 74 o Y aw
Fusiwaziveavestoyamsaumagimaas i lalunise
Y ]
sudoyavesouuliauysal ieanngadavesouuusnunenlil
tﬂ' 1 -2
1NAD AU
k4 1 i
v 9 ~ Y Y o a A 1T @
Fudeyavesnuungnud lvldyadavesnuuuTnuNLenFeuaenY
L 1 @ [l
msilszgnd 19 Tsunsu ALOHA sawnuTisunsy ArcGIS ludiuves
2 ddu e :
Mt U 185 umanszNU91nM 552 11iaveq Propanc
o 1 @ 1
msilszgnd 19 Tsunsy ALOHA sawnuTisunsy ArcGIS ludiuves
dy A Yo a
MIUAAINUNN 1A DNANTZNUIINMI521TAV0 Propylene
; 2 4 4 , oy v < u (s
idunaniiszezdunganlylumsdedn lasviany lddsanena

Y ]
Tuiui

Qe

v A 4 deuyu & A -
IETUNNNUITYSTY qulwiuﬂ1iaW8WﬂuaaﬂuaﬂwMVIm1¢w1

Qe

v v
= =

v A 9 & A -
Lﬁuvnqwuizﬂzauwquiwiuﬂ1iaW8WﬂuaaﬂuaﬂWuv1m1¢w2

ANNYUDINATIN IATLHO

(4)

39

42

43

43

44

45

46

46
47

78



)

Mmetinadydnuainazmde

Mo 1EdNHIE0
ALOHA = Areal Location of Hazardous Atmospheres
BLEVE = Boiling Liquid Expanding Vapor Explosion
GIS = Geographic Information Systems
LEL = Lower Explosion Limit
LOC = Levels of Concern
TEEL = Temporary Exposure Limits
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MNN 1 Gaussian distribution (left) and Gaussian spread (right).

11: U.S. Environmental Protection Agency (2006)
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11: U.S. Environmental Protection Agency (2006)
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M135190 1 ALOHA sources and scenarios.

Source Toxic Scenarios Fire Scenarios Explosion Scenarios
Diirect
Direct Releass Toxic Vapor Cloud | Flammable Ares (Flash Firs) | Vaper Cloud Explosion
Puddle
Evaporating Toxic Vapor Clond | Flammable Area (Flash Fire) | Vapor Cloud Explosicn
Buminz (Pool Fire) Pool Fire
Tank
Mot Buming Toxic Vapor Cloud | Flammahle Area (Flash Fire) | Vapor Cloud Explosicn
Burming, Jet Fire or Pool Fire
BLEVE BLEVE (Fircbhall and Pool Fire)
Gas Pipeline
Mot Buming Toxic Vapor Cloud | Flammable Ares (Flash Firs) | Vaper Cloud Explosion
Burning (Tet Fire) Jet Firs

11: U.S. Environmental Protection Agency (2006)

[ { [l I a [
asaivane 9 arfiegluTisunsuALOHA wenvnvzidlunibudrde ] 1Wan
=& @ oA A 1 9 o < a
Fulusuasieoddulonglue1na uenain ALOHAW @ wNTaai wuuuIIaesn iy
Y o Y o a Y a Iy 9 o A F) =~
udrdsannsaadauuuiaesmang W' luiuazmssuiia ldonae Taevinazuuy aransni
) a ] o o v 0 [
adlunbaz 11 1y Acrolein 52 lvavonun idedlFuuuiiasimnszaedineuas 'l
Yo ] a 9 o :JI o @
1¥$aeumamsal Il lnsivazmsszida wdnhwannisaesmuiiaeslilaaluunuds
v 9 ) A A 9 9 v A [ wAa 3

Usznounuveyadumzou q e ldiludoyamsdaduleneusugliameiiv Turaiey 9

4 9 o a A o @ 1 9 a
manisa mﬂ@ma‘umiﬁa‘lwaéuaawyummmmgmnmﬂﬂ”lwmmzmiizmﬂ

Y ]
22.1 vl (Fire) Ao Unsengn Isveudemasnuoendnunlianuiou aiu

sazuaaadn Ionmaniidiulvginaninmagalsemennuvasans 9w Uszme’l

%

Tihade anudou nsenadlanuvasdy q sswmlivedinteuy

Q

pian IWon Tuia
i

(Autoignition) 9z@Aa 19 1A Tae ludeserdemsyailsznie inlgungiiganiiguugil

QU

aalnon Tuiave iy



= a % d'o/ 1 09/’ a Y 1 =
Hgungiundnianmsiu q aalildhevinaluu szvenanis
o A 1 e . = o w oge
TIWAIND NITILNENY(Volatility) fgﬂ?”l“ullw (flash point) vadrannu'lu (flammability
' IS EZ { i< < A & ' 1A A '
limits) M3szmedeunuauiavesars hldinaedule 1851 susulusoedalilde

9 v 1
mdu veuvadr hlidesnaeidiuledeuiazdali v lifugamgidganars

u

=) [

wizmonazndounazda lilld ganulvasdasdinnudeaenmsaa v dasivaniula i

1 I o w a 1 . .. o w a
uie Idfuiasinaszidinans (Lower Explosive Limit: LEL) HazIRINANITZIIAUY (Upper

vunazarsaziluaeileszmevesms h W luoimeda i ldheiige asnindauautia

| o % AN o v 1 A o Y
miﬂmmﬂu"laqmazqmm”Mm UNITUUAVINAANUDINITISIUAN 1N IY

¥ ] ' Y
dioas 1 lwaa IWuddesordeaudsnii i ldaae 111470 oimaq

pondau uazanudoudimiadilaeenlinfezdy

9 v 1 Y a a)dl A [ [] dyﬂl
M3 milvee lndineldinananaseldon Ao atu i ud uag
=1 1 Aaaa =1 d! v @ I % [l o
maaligduunlndanidgnsenadl Fsundindumsouasis ALOHA luamnsnsiaes
Y] @ 9 I ¥ 1 9 Y T Al Y
VLIUMITOUFUFDUVINM T 11T 1 uaausldmanziuanusounmunsaa 1a
B Y I o Y v A Y o Y a Y
msursIanusou uonvnaztlusuaiielasnsdrdainanmedonlumsildnaln v
A a oy 9 a Y Y
nsesziasdouluusnalndifeslaon
FEAUNINDITUIVOINIUNTIANNS 01 (Theminal Radiation Levels of

Concern, LOC) i 331109030 UAT18910MIUHSIdANNuTou 1o ld ALOHATUMIA UL

© 2D

[

o A o < [ v I a v Jd A g Y
UUITUDNUANNAULUUTINTEAD (’msﬂuﬂa’mmamimm’i) LW'E)L‘]JH"IJ@‘]JL"U@'Iﬂ"ITﬂf‘NﬂH

=D

a v A Aa Y a =\
-1ad : 10 dladad/maruuas @1ade3a lanielu 60 3ui)
-du -5 aladad/maamas (Aams ludszau2nielu 60 1)

a v a 9 a
- 11894 : 2 D ladad/maamas (aae1msiiadeunielu 60 Jui)

4
5% ' J. Y [ 1
HANTZNUIINMIUASITANNS DUABNYBITUR DT ZAUAINA1 AR
v @ { ' o 1 s 9 qul
Tumsduda vouwafiuaainalu ALOHALNUONDITZAUANUTULTIADNYBINS DU

] Y
douuziihlumsnindiiensaea Loc 1u ALOHA a23 19aua1ing 2



M1319% 2 Thermal radiation burn injury criteria.

Radiation Intensity (kW/m?) Time for Severe Pain (s) Time for 2nd Degree Burns (5)

1 115 663

2 45 187

3 27 92

4 18 57

5 13 40

6 11 30

8 7 20
10 5 14
12 4 11

11: U.S. Environmental Protection Agency (2006)
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224 52AUANNEINYUDINAUANUAU(Overpressure Levels of Concern: LOC)
I o 1 @ 2 o - 1
WudlsuenszAuANUTUITIIoIRAUANNAUINMTTZIdN H91151n50 ALOHA
] I [

guseanuaIusEay

- 14 : 8.0 psi (1180113 19)

o < o
- &u: 3.5 psi (M 1FaRuaia’ld)
11899 : 1.0 psi (uﬁ"ummﬁzmﬂ)

Y A

A [ [ o w dy Y
mataenlamszauanudiyilildaisen 3

319N 3 Explosion overpressure damage estimates.

0‘-91-[]“.?““1?” Expected Damage
(psig)
0.04 Loud noise {143 dB): sonic boom glass failure.
0.15 Typical pressure for glass failure.
0.40 Limited minor structural damage.
0.50-1.0 Windows usually shattered; some window frame damage.
0.70 Minor damage to house structures.
1.0 Partial demolition of houses; made uninhabitable.
1.0-2.0 Corrugated metal panels fail and buckle. Housing wood panels blown in.
1.0-8.0 Range for slight to sertous laceration injuries from flying glass and other missiles.
2.0 Partial collapse of walls and roofs of houses.
2.0-3.0 Non-remforced concrete or cinder block walls shattered.
24-122 Range for 1-90% eardrum rupture among exposed populations.
2.5 50% destruction of home brickwork.
3.0 Steel frame building distorted and pulled away from foundation.
5.0 Wooden utility poles snapped.
5.0-7.0 Nearly complete destruction of houses.
7.0 Loaded train cars overturned.
9.0 Loaded train box cars demolished.
10.0 Probable total building destruction.
14.5-29.0 Range for the 1-99% fatalities among exposed populations due to direct blast effects.
* These are peak pressures formed in excess of normal atmospheric pressure by blast and shock waves.

11: U.S. Environmental Protection Agency. (2006)
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Processing Condition
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Processing Condition

- Pressure 500 mm.H,0 - Temp.-102 c® - Inventory 4,000 tons - PHASE Liquid
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wu1agUnIal (Outer Shell Size)
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tﬂy Aa 2
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Processing Condition

- Pressure 17 kg/cm2 - Temp. Ambient c® - Inventory 1,800 tons - PHASE Liquid
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Processing Condition

- Pressure 0.5 PSI - Temp. -40 c° - Inventory 6,000 tons - PHASE Liquid
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ArcMap ALOHA Import Tools

The ALOHA Import Tools enable the import of ALOHA footprint (.pas) files into

ArcMap. If you are running...

- ArcMap 9.2, you should use the aloha 92.dll file (released 3/15/07).

- ArcMap 9.0 or 9.1, you should use the aloha 91.dll file (released 1/04/07; updated
3/15/07). (A previous version of aloha 9.dll fixed a bug that existed in the aloha 8.dll version, in

which the use of certain release units caused the Tool to fail.)

- ArcMap 8.x, you can still use the aloha_8.dll file (released 7/23/04; "bug fix" 4/29/05),
but be aware that using units other than "ppm" for your chemical release may cause the Tool to

fail.

Downloading the Import Tool

1. If your browser supports FTP downloading (most current browsers do), download the
appropriate file by clicking the link below. Otherwise, you can use an FTP utility

(http://archive.orr.noaa.gov/cameo/cameoftp.html).

Download aloha 92dll.zip

from “ftp://ftp.orr.noaa.gov/pub/hazmat/cameo/aloha 92dll.zip”
Download aloha 91dll.zip

from “ftp://ftp.orr.noaa.gov/pub/hazmat/cameo/aloha 91dll.zip”
Download aloha 8dll.zip

from ftp://ftp.orr.noaa.gov/pub/hazmat/cameo/aloha 8dll.zip
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These files are in zipped (compressed) format so that they can be downloaded from the
Internet. They are self-extracting zip files, so look for the file, aloha 92.dll, aloha 91.dll, or
aloha_8.dll. (Your computer may display a message that it is unable to open the file because it
does not know what application created it. You can disregard this message and continue with step

two.)

2. Save the uncompressed file to your hard drive. We recommend that you save it with
the other ArcMap DLLs in the directory, C:\arcgis\arcexe9x\bin (or C:\arcgis\arcexe8x\bin, as

appropriate).

Installing the Import Tool

After you have saved the uncompressed file (aloha 92.dll, aloha 91.dll, or aloha 8.dIl,

as appropriate) to your hard drive ...

1. Launch ArcMap.

2. Right-click on the ArcMap toolbar and scroll down to Customize... (or choose the

Customize. .. option under the Tools menu).

3. Select the Commands tab on the Customize... window.

4. Click the Add from file... button. Navigate to the .dll file on your hard drive. (If you
don't see the file, your browser may not have automatically unzipped the compressed version. Try
using WinZip or Stuffit Expander.) Select the file and click Open to add the ALOHA Import Tool

to your available tools. Click OK.

5. In the scrollable list on the left side of the Customize... window, highlight
ArcObjectTools. To the right you should see the Aloha Footprint Extension (vs 1.1) command (or

in ArcMap 8.x, the Aloha Footprint Extension command).
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Note: If you are upgrading from the aloha 8 Tool, while this window is open, select the hula girl

icon that is currently on your tool bar and drag it off the tool bar.

6. Click the hula girl icon next to the Aloha Footprint Extension (vs 1.1) command (or in
ArcMap 8.x, the Aloha Footprint Extension) and drag it onto your standard toolbar. Release the
mouse button when your cursor becomes a vertical bar. (You need to release the mouse button at

or before the last icon on your toolbar.)

7. Exit the Customize... window.

You are now ready to use the Aloha Footprint Import Tool!

Using the Import Tool

When the footprint option is chosen from ALOHA, a file entitled alo_ftp.pas is created
and placed in the ALOHA directory. This file will be deleted when ALOHA is shut down, so it is
best to rename the file in case you want to import the footprint into ArcMap after ALOHA is off.
Be sure, however, to retain the .pas suffix so that ArcMap will recognize the file as an ALOHA

footprint.

To use the ArcMap Tool, simply click on the hula girl icon. You will be guided through
the import process. You will need to provide the source site of the release, either in decimal
degrees or degrees, minutes, and seconds. The geodatabase that is created will have a defined
coordinate system (geographic coordinates, WGS-84). This allows ArcMap to reproject the
footprint layers if you have other data layers in a different, defined coordinate system.

You will also need to navigate to the ALOHA footprint .pas file and can specify an alternate
name for the geodatabase (the default will be the name of the chemical released).

The mapped output will include a layer for each level of concern specified in the ALOHA .pas
file. The layers will be named with these levels of concern. In addition, a balloon callout box

containing the parameters of the spill and other relevant information is displayed. This box and
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the red dot showing the release site are graphic elements and may be moved or deleted using the

graphic selection tool.

With the aid of this tool, you will be able to view and query the ALOHA footprint output

with other data layers available for your ArcMap session.

Removing the Import Tool

To remove the ALOHA Import Tool from your toolbar, open the Customize... window

and drag the hula girl icon off the toolbar.



MANHIN 3

ArcGIS Network Analyst Tutorial

84



85

Creating a shapefile based network dataset

In this Exercise you will create a simple shapefile based network dataset from a single

line feature class and a turn feature class.
Creating a network dataset

1. Start ArcCatalog by either double-clicking a shortcut installed on your desktop or

using the programs list in your Start menu.

2. Navigate to the C:\arcgis\ArcTutor\Network Analyst folder in the Catalog Tree. (This

is the default install location for this data.)

3. Click the Exercisel folder to show its contents.

=« ArcCatalog - ArcView - D:AGIS

File Edit Yiew Go Tools Window Help

o E3 i B X % E @D O
| Lacatior: jD:\GIS ﬂ
Styleshest: J [ ESRI _J
2| Cantents ] Pleview] Metadata]
B Catalog ~
T Li o — | _Mame 1 Type
= oy @thesis_rayong.mxd Map Document
+-[_] aloha [rayong Faolder
=L ALOHA_ArcGis_DATA [ maptaput Falder
[+ ETHAN
[+ ETHYLENE
=1 aI5
=L maptaput

@ -{_] Export_Cutput_MND.nd
#1-{Z] new_ND.nd
I a Mput. rdb
i+ £33 Mew Personal Geodatabase.mob
[+ g Test.mdb
EQ bldg.shp
B Ffinal.shp
P final_MDLND
final_MD_Junctions.shp
E1 landuse.shp
EQ railedge.shp
B raibway.shp
B roadd.shp
B roadd_new.shp
=1 roadedge.shp
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4. If the Network Analyst Extension is not enabled, on the Tools menu, click Extensions,

and in the Extensions dialog, click Network Analyst and close the Extensions dialog.

5. Right-click the Streets shapefile and choose New Network Dataset.This shapefile

contains street data for downtown San Francisco.

] Streets <hn Shans
Copy Ctrl+C
X Delete
Rename F2
Create Layer...
Export ke

@ Mew Metwork Dataset,..
h B auimindHarastslv A r]z"in:.-:-c-c.-

6. The name of the network dataset is set to Streets ND by default.

Network Connectivity defines how features that participate in a network connect to each
other. The default connectivity for a network dataset places all sources in one connectivity group
and assigns all edge sources endpoint connectivity. In a shapefi le based network there is only one
edge source, hence there is no need for multiple connectivity groups. Also, we wish to model

streets with endpoint connectivity. (To see how this is modeled, you may click the Connectivity

button.)

7. You will accept the default connectivity, therefore Click Next to continue.
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New Network Dataset

The default connectivity settings for network, datazets establish connectivity
only at coincident endpointz of line features during the build process.

[f pow want to uge different connectivity zettingz, click the Connectivity buthan
below, vou can change the connectivity zettings now, or you can change
them after the network. datazet has been created.

Connechivity. ..

¢ Back Meut » Cancel

Earlier versions of ArcView GIS and ARC/INFO support optional elevation fields to
establish connectivity. Each feature in a shapefile or a coverage would be assigned two Z-
elevation values, one for each endpoint. If the endpoints of line features have the same Z-
elevation value, connectivity is established. If the values are different, they do not connect (e.g. in

the case of bridges or tunnels).

The elevation field contains logical elevation values for establishing connectivity only
and does not provide height information for the feature. ArcGIS Network Analyst can use this
data to modify the connectivity settings established in the previous step. ArcGIS Network Analyst

automatically searches and maps the relevant fi elds.

8. Click Next to accept the default elevation fields settings. If ArcGIS Network Analyst
finds elevation fields data in your shapefile, it automatically chooses the Yes radio button and

assigns the appropriate fields
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ArcGIS Network Analyst supports turns in a shapefile based network. Turn information

(such as turning restrictions and delays) enhance the quality of network analysis. Earlier versions

of ARC/INFO and ArcView GIS used turn tables. These turn tables can be converted

into turn features and used in the network dataset. You will use turn features in Exercise 2.

In addition, by default Global Turns are selected. Global Turns are rules that can be set,

such as all left turns have a delay of 15 seconds. Such a rule gives preference to right turning

movements. The advantage of Global Turns is that you do not need to create individual

turn features for rules that apply to every turn in the network.

9. Click Yes to model turns in the network.

10. Click Next to continue.
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Network attributes are properties of the network that are used to control navigation.
Common examples are costs that function as impedances over the network. Restrictions like
oneway traversal are also examples of network attributes. The ArcGIS Network Analyst analyzes
the source shapefile and looks for common fi elds like Meters, Minutes (FT_Minutes and
TF_Minutes, one for each direction), and Oneway. Once it finds these fields, it automatically
creates the corresponding network attributes and assigns the respective fields to them. (This can

be viewed by clicking the Evaluators button.)

11. Since the attributes are automatically defined and assigned values, click Next to
continue. To use driving directions in a network analysis, they should be set in the network

dataset.
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12. Select Yes to establish driving directions settings for this network dataset.
The Network Analyst automatically finds and maps the field in the streets source that will be used

to report street names. Additionally Length and Time fields are automatically mapped as well.

13. Click Next to continue.




14. A summary of all the settings that have been chosen is displayed in the following

window for your review. Click Finish to create the new shapefile based network dataset.

New Nebwork Dataset

_H ew Nebtworlk Dataset

Once created, the system prompts for the network to be built.

15. Click Yes to build the network.

91
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New Network Dataset =i

The new network dataset has been created. Would you like to build it now?

The network dataset has been built when the progress bar disappears.

Build Network Dataset

The shapefile based network, Streets ND, is added to ArcCatalog along with the system

junctions shapefile Streets ND_Junctions.

16. Select Streets ND and click on the Preview tab to see the built network dataset.
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17. Close ArcCatalog.
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Finding the best route using a network dataset

In this Exercise you will find the best route for the given order of stops based on travel

time.

Preparing your display

1. If you have Exercise4.mxd open in ArcMap, skip steps 2 to 5.

2. Start ArcMap by either double-clicking a shortcut installed on your desktop or using

the programs list in your Start menu. Choose Ok to start ArcMap with a new empty map.

3. Click File on the Main menu and click Open.

4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network Analyst\Exercise4.

(This is the default install location for this data.)

5. Double-click Exercise4.mxd.

6. If the Network Analyst Extension is not enabled, on the Tools menu, click Extensions,

and in the Extensions dialog, click Network Analyst and then close the dialog.

7. If the Network Analyst toolbar is not already present, on the Main menu, click View,

point to Toolbars, and click Network Analyst.

F
Network Analyst = ”E;‘ N - |Nelwork Dataset: Igtreetg_nd ;] e A

8. If the Network Analyst Window is not already open, click the Network Analyst

Window button on the Network Analyst toolbar.
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This is a dockable window which you can dock within the ArcMap window or leave

undocked. In this Exercise the window is docked below the Table of Contents.

Network Anast Window

Creating the Route analysis layer

1. On the Network Analyst toolbar, click the Network Analyst dropdown menu and click

New Route.

W”‘““’; i ¥ Iﬂ-u-i.nu-hpm red

The Network Analyst Window now contains empty lists of Stops, Routes and Barriers

categories.
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Route LI

Stops (0)
Routes (0)
Barriers (0)

Additionally, the table of contents contains a new Route Analysis Layer.
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Adding a stop
Next, you will add the stops between which you will be creating the best route.

1. Click Stops(0) on the Network Analyst Window.

2. On the Network Analyst Toolbar, click the Create Network Location tool hﬁ: .

3. Click anywhere on the street network in the map to define a new stop location.
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The program then calculates the nearest network location and symbolizes the stop with
the located symbol. The stop will remain selected until another stop is placed or until it is

unselected.

The located stop also displays the number 1. The number —— : l;_ represents the order

in which the stops will be visited by the calculated route.

You will also notice that the Stops category on the Network Analyst Window now lists 1

stop. Expand the Stops category to see the Graphic Pick 1 listed there.

!Route ﬂ

Barriers (0)

4. Add two more stops on the map. The stops are numbered 2 and 3. The order of stops

can be changed on the Network Analyst Window.

The first stop is treated as the origin and the last, as the destination.

[ B

= Stops (3)
apiec Pick 1
e Pk 2

Routes (0)
Barriers (0)




If a stop is not located on the network, it will appear with an unlocated symbol.

An unlocated stop can be located on the network by moving it, closer to any edge that

belongs to the network. On the Network Analyst Toolbar, click Select/Move Network Location

Using the Select/Move Network Location tool ' i3 , click and drag the unlocated stop

closer to an edge on the network.

97
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Setting up the parameters for the analysis

Next, you will specify that your route will be calculated based on time (minutes), that

U-turns are allowed everywhere, and that one-way restrictions must be followed.

1. Click the Analysis Layer Properties button next to Route layer on the Network Analyst

Window to bring up the Layer Properties dialog for Route.

Route :_I
Stops (3)

Routes (D)
Barriers (0)

2. In the Layer Properties dialog, click the Analysis Settings tab. Make sure the

impedance selected is Minutes (Minutes).

3. Do not use time windows. (Leave the box unchecked). Time windows are used when

certain stops can only be visited at certain times.

4. Do not reorder stops. (Leave the box unchecked). This preserves the order of stops as

decided by you, when you created the stops.

5. Choose Everywhere from the Allow U-turns dropdown box.
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6. Choose True Shape from the Output Shape Type dropdown box.

7. Check the box labeled Ignore Invalid Locations. This will let you find the best route

using located stops. Stops that were not located on the network will be ignored.

8. Check Oneway in the Restrictions list.

9. Check the Directions settings.

10. Make sure the Distance Units are set to Miles, the Use Time Attribute box is checked

and the time attribute is set to Minutes.

11. Click OK.
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Run the process to compute the best route

1. Click the Solve button - on the Network Analyst toolbar. The route polyline

appears in the map and in the Route category of the Network Analyst Window.

2. Click the plus (+) sign next to Routes on the Network Analyst Window to show the

Route.

3. Right-click the new route called ‘Graphic Pick 1 - Graphic Pick 3’ and click Directions

Window to display driving directions.
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Barriers (0)

4. The Directions Window can also be displayed with turn-by-turn maps that can be

shown by clicking on the Map link.
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5. Close the Directions Window.

Adding a barrier

In this section, you will add a barrier on the route, that represents a road block and will

find an alternate route to the destination, avoiding the road block.
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1. In the Window menu, click Magnifier to bring up the Magnifier window.

2. Click on the title bar of the Magnifier window and drag to reposition the Magnifier

window.

3. Move the Magnifier window over the route, to a point where you want to add a barrier.

The Magnifier window shows a part of the map where you can add a barrier at a zoom of 400%.

4. On the Network Analyst Window, click Barrier (0).

5. On the Network Analyst Toolbar, click the Create Network Location tool ﬁt‘ .

6. In the Magnifi er Window, click anywhere on the route, to place a barrier.
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7. Click the Solve button ﬁ on the Network Analyst toolbar. A new alternative route

is computed, avoiding the barrier.

8. Close the Magnifi er Window.
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Saving the best route

1. Right-click Routes (1) on the Network Analyst Window and click Export Data.
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2. Type in a location and shapefile name to save the results such as

C:\Data\Exercise4 Route.shp in the Output shapefile or feature class field.

3. Click OK. The best route generated is saved to the specified shapefile.

4. Click NO when prompted to add the exported data to the map as a layer.

5. If you do not plan to work on any other Exercise, close ArcMap. Click No to discard

all changes.
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! : Save changes to Tutorial4.mxd?

Yes
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6. If you do plan to work on other Exercise, then do a File New in ArcMap and Click Yes

to discard all changes to the current map document.
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